
CHAPTER 1
Introducing ArcGIS 
LEARNING GOALS

• Get an introduction to ArcGIS®.

• Get an introduction to the ArcGIS Pro user interface.

• Learn to navigate maps.

• Work with tables of attribute data.

• Get an introduction to symbolizing and labeling maps.

• Work with 2D and 3D maps.

Introduction

A
rcGIS is an integrated collection of geographic information system (GIS) software 

developed by Esri® that works seamlessly across desktop computers, the internet, 

and mobile devices. The tutorials in this first chapter will familiarize you with a 

major component of this suite: ArcGIS Pro. ArcGIS Pro is a 64-bit desktop GIS application 

that uses a ribbon interface for 2D and 3D map authoring, analysis, and web publishing. 

You’ll use additional ArcGIS apps in other chapters. 

In this chapter, you will work with a finished map in ArcGIS Pro that has the locations of 

urgent health-care clinics in Allegheny County, Pennsylvania. These clinics are (1) federally 

qualified health centers (FQHCs) that provide subsidized health care for underserved pop-

ulations and (2) nonsubsidized clinics that provide health care (called urgent care clinics 

in this book). You will become familiar with the software, learn how the map works, and 

analyze the locations of both types of health-care clinics to see whether they are sited in 

appropriate locations.
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Tutorial 1-1: Getting an overview of ArcGIS Pro

Before starting work on your computer, review this terminology for ArcGIS Pro 
projects and spatial data. 

•	 A feature class is the basic building block for displaying geographic features 
on a map. You can think of a feature class as a homogeneous layer on a map. 
Feature classes are vector data and have corresponding attributes for each 
feature. For example, you will work with a point feature class named FQHC 
Clinics that has points for all FQHCs in Allegheny County. In addition, 
Streets is a line feature class that has centerlines for all streets in the county, 
and Municipalities is a polygon feature class that has boundaries for all 
municipalities in the county.

•	 A raster dataset (or raster) is a major type of spatial data. A raster is an image 
made up of pixels—squares so small that you can’t see them until you zoom 
in. A common example of a raster is satellite imagery. A raster encoded with 
geographic coordinates can be used as a layer in a map.

•	 A file geodatabase is a folder with the extension .gdb that stores feature 
classes, raster datasets, and other related files. Although many other file 
formats are used for storing spatial data, the file geodatabase is a preferred 
Esri format. The data used in the Tutorial 1-1 project is in the Chapter1 file 
geodatabase, stored in the Chapter1\Tutorials folder on your computer. 

•	 A project is a file with the extension .aprx that contains one or more maps 
and related items. For example, you’ll open Tutorial1-1.aprx after this 
introduction. This project has two maps, Health Care Clinics and Health 
Care Clinics_3D, plus other project items. A project doesn’t contain spatial 
data (such as the feature classes you may use on your maps)—it simply pulls 
in spatial data that’s stored elsewhere, such as in a file geodatabase. A project 
can be stored in a location of your choice. 

Set up the Tutorial 1-1 project

You’ll start by opening a project in ArcGIS Pro. The opening map has 12 layers avail-
able for Allegheny County but only one turned on—a layer for population density 
by census tract from the 2020 census. The city of Pittsburgh is in the center of the 
county.

1.	 Browse to links.esri.com/GISTforPro3.1Data to download the tutorial data for 
the book. Download and extract the files to your local drive.

2.	 Start ArcGIS Pro on your computer.

GISTPro3-4.indb   4GISTPro3-4.indb   4 3/3/25   2:14 PM3/3/25   2:14 PM

Copyright © 2024 Esri. All rights reserved.



5

Part

1

Chapter

1

Tutorial

1

GIS Tutorial for ArcGIS Pro 3.4Chapter 1: Introducing ArcGIS 

3.	 Sign in with your ArcGIS account username and password. If you don’t already 
have a license, see the licensing options at the beginning of this book in the 
section “About This Book.”

4.	 Click Open another project. In the Open Project pane, browse to \EsriPress\
GISTforPro\Chapter1\Tutorials and double-click Tutorial1-1.aprx. 

The project opens and displays a map called Health Care Clinics. 

5.	 On the Map tab, click Bookmarks > Allegheny County. 

The bookmark centers the map to fill the view.

6.	 In the Contents pane, scroll down to see the legend for the Population Density 
layer. 

This groups the census tracts into nine classes. A white-to-black color scheme 
shows how many people live there per square mile, in increments of 1,000.

7.	 On the Project tab, click Save Project As, browse to Chapter1\Tutorials, and 
save the project as Tutorial1-1YourName.aprx (substitute your name for 
YourName). 

You’ll generally open and save projects for each chapter this way. If you make a 
mistake, you can start again with the original project.

Map of Allegheny County showing 
population per square mile by census 
tract.
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Add and remove a basemap

A basemap is a layer that helps orient users to a location. Map designers place 
additional feature classes on top of a basemap to provide specific information for 
visualization, analysis, or problem solving. Although you can create your own base-
map, Esri provides the basemaps you’ll use in this book. These basemaps are stored 
in ArcGIS Online. 

1.	 On the Map tab, in the Layer group, click Basemap. 

You’ll see a variety of basemaps—available basemaps depend on licensing.

2.	 Click the Streets basemap to add the basemap to your map. 

The Population Density feature class covers most of the Streets basemap. 

Because the basemap doesn’t add useful information in this case, you’ll remove it.

3.	 Scroll to the bottom of the Contents pane, right-click World Street Map, and 
click Remove.

Map of Allegheny County showing 
population per square mile by census 
tract and Streets basemap.
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Turn layers on and off 

The order in which feature classes are drawn is shown in the Contents pane. The 
feature class at the bottom of the pane is drawn first, and each layer above it is 
drawn in turn on top of the preceding layer until you reach the top of the list. 
Feature classes that cover large areas, such as Population Density, must go on the 
bottom. Other feature classes that may be covered by other layers—such as FQHC 
Clinics, which has points—must go higher in the list to be visible.

1.	 In the Contents pane, scroll down to see the legend for Population Density. 

The check mark on the left of Population Density indicates that the feature 
class is turned on. 

2.	 In the Contents pane, check the boxes for Urgent Care Clinics, FQHC Clinics, 
and Poverty Risk Area. 

The three feature classes you just turned on are the subject of this map and 
show the locations of urgent care clinics relative to poverty risk areas. Right 
away, you’ll notice that the subsidized FQHC clinics tend to be concentrated in 
areas of high population density (urban) and poverty risk, whereas the non-
subsidized urgent care clinics are mostly spread out in areas of low population 
density (suburbs). Areas inside the poverty risk area polygons have high propor-
tions of poor populations, as determined by the number of households below 
the poverty income threshold (using average American Community Survey data 
for the five-year period ending in 2019). The locations of FQHC and urgent care 
clinics are from 2022.

YOUR TURN
The Your Turn assignments in this book ask you to repeat the steps 

just completed but with some modifications. These assignments help 

you retain the workflows in the steps. Often, you’ll need to complete 

the Your Turn assignments so you can use their results in the next 

tutorial steps, so don’t skip Your Turn assignments.

For this Your Turn assignment, add and remove several basemaps 

of your choice. You’ll notice that some basemaps, such as Light Gray 

Canvas, add a labeling reference layer at the top of the Contents 

pane. When you remove those basemaps, remove the corresponding 

labeling layer, too.
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3.	 Turn on feature classes that provide the spatial context of where subject features 
are located: Pittsburgh, Allegheny County, Rivers, and Streets. 

Streets, an important spatial context feature class, won’t display until the map 
is zoomed in to a small area (you’ll learn about zooming later in this chapter). 
There are too many detailed streets for viewing at full extent. 

Reorder feature classes in the Contents pane

To make the point that ArcGIS Pro draws from the bottom up in the Contents pane, 
you’ll temporarily drag Population Density higher to cover other feature classes.

1.	 Drag Population Density to the top of the Contents pane, under Health Care 
Clinics. 

Now this feature class covers all other feature classes in the map.

2.	 Drag Population Density back to directly above the Poverty Density feature 
class. 

3.	 At the top of the screen, above the ribbon, click the Save Project button. 

Map of Allegheny County showing 
population per square mile by census 
tract, urgent care clinics as points, 
FQHC clinics as points, poverty risk area 
boundaries as polygons, and rivers as 
lines.
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Some ribbon buttons don’t have labels. To identify the button you need, posi-
tion the pointer above the button to view a pop-up ScreenTip. The Save Project 
button saves the entire project.

Examine the Catalog pane and open and export a map layout 

The Catalog pane provides access to all components in an ArcGIS Pro project.

1.	 On the View tab, in the Windows group, click Catalog Pane. 

The Catalog pane appears. 

2.	 If the pane isn’t docked on the right side of the ArcGIS Pro window, right-click 
the top of the pane and click Dock.

3.	 In the Catalog pane, click the arrows on the left of both the Maps and the 
Layouts folders to expand the folders, revealing what’s been built so far for this 
project. 

You are viewing the Health Care Clinics map, but you’ll also view a 3D version 
of the same map at the end of this chapter.

Catalog pane showing available maps 
and layout.

GISTPro3-4.indb   9GISTPro3-4.indb   9 3/3/25   2:14 PM3/3/25   2:14 PM

Copyright © 2024 Esri. All rights reserved.



Part

1

Chapter

1

Tutorial

1

10 Chapter 1: Introducing ArcGIS GIS Tutorial for ArcGIS Pro 3.4

4.	 In the Catalog pane, under Layouts, double-click FQHC and Urgent Care 
Clinics. 

ArcGIS Pro displays the layout on a new tab, next to the tab for the map. The 
map is the main element of a layout, which also includes the title, legend, and 
scale bar. You’ll learn about making layouts later.

5.	 At the upper right of the Catalog pane, click the Auto-Hide button (the push-
pin) to temporarily hide the pane. 

The Auto-Hide button will collapse the panes along the edge of the screen. You 
can restore and hide the Catalog pane as needed by clicking the Catalog tab.

Next, you’ll use a tool to export the map layout as an image file that can be used 
in a report or presentation or on a website. ArcGIS Pro has hundreds of tools, 
and you’ll use many of them in this book. Each tool has a dialog box (a pane) 
for values (parameters) you need to add to run the tool, generally by choosing 
values from lists or entering values by typing.

6.	 On the Share tab, in the Output group, click Export Layout. 

The Export Layout tool pane opens, ready for you to add and type parameters 
as needed to export an image file of the layout.

Layout with map of FQHC and Urgent 
Care Clinics, including map title at the 
top, legend for map layers at the right, 
and scale at the bottom.
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7.	 Complete the following steps to add parameters:
•	 On the File Type drop-down menu, click PNG.
•	 For Name, click the Browse button, browse to save the file to your desktop, 

and rename it FQHCAndUrgentCareClinics.png. 
•	 For Resolution, type 150.
•	 On the Color Depth drop-down menu, click 24-bit True Color.
•	 Click Export to run the tool. 

8.	 On your desktop, double-click FQHCAndUrgentCareClinics.png to open the 
image in a photo viewer. 

9.	 Examine the image and close the photo viewer.

10.	 Click Save Project to save your project. 

Export Layout tool pane with parameters 
set.
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YOUR TURN
Next to the FQHC and Urgent Care Clinics layout tab, click the 

Health Care Clinics map tab to activate it. In the Contents pane, 

turn on the FQHC Buffer and Urgent Care Clinics Buffer feature 

classes. The FQHC Buffer shows circles with a one-mile radius, and 

the Urgent Care Clinics Buffer shows circles with a five-mile radius, 

each drawn around its respective clinics. Allegheny County, outside 

Pittsburgh, consists mostly of suburbs for which expected travel dis-

tances are greater than distances in urban areas. The buffers are partly 

transparent, allowing you to see the population density below them. 

By comparing the clinic service areas and the population density, you 

can get an idea of how services are apportioned. Next, switch back 

to the Layout tab. ArcGIS Pro has already added the newly displayed 

feature classes to the layout map and legend. When you’ve finished, 

save your project.

Layout with map illustrating the service 
areas for FQHC and Urgent Care Clinics 
using buffers and including map title 
at the top, legend for map layers at the 
right, and scale at the bottom.
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